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Agency Manager - Notifying Agencies Correctly 

If the Notify selected agency contacts field is unchecked when a req is unposted from an 

Agency Manager, no notification e-mail is sent to the Agency contacts (as would be 

expected). 

How It Worked Before 

Agency reqs are posted to and removed from the Talent Gateway based on a check mark 

beside two options for notifications. One of those options was sending notifications to 

Agency contacts even if the box was not checked. 
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Assessment - Results are in the User’s Language 

The scored results for Assessments are associated with the user’s login, which is stored in the 

URL. As a result of this enhancement, a language parameter is stored in the URL as well. As 

a result, when the assessment module or partner returns the results to a multiple language 

Talent Gateway, it is attached to the correct Talent Record for that language. 

How It Worked Before 

The scored results were associated with the user’s login (stored in the URL). When the 

assessment module or partner returned the results, they were not attached to the correct 

Talent Record for that language. 

Benefits 

Assessment results are attached to the correct Talent Record and are in the correct language. 

Costs 

There is no additional cost for this feature. 

Date Available 

This feature is available in R11.5, Build 2 on January 29, 2009. 

How Do I Get this Feature? 

This feature is available automatically for clients using Assessments. 

Visible Changes 

If your organization uses Assessments in languages other than US English, Assessment 

results in the correct language are stored on the candidate’s Talent Record. 
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Communication - Extended Signature Token across 

Module 

The signature tokens are available for all templates in the Communications Module.  

A signature field contained in the User’s profile provides a place to record specific required 

company information. The tokens reference the stored signature when generating system and 

non-system correspondence. 

Business Need 

The “signature token” functionality addresses the EU compliance directive, stated in 

Directive 2003/58/EC of the European Parliament and of the Council. This implementation 

addresses the specific concerns for interpretation of compliance in Germany. 

Benefits 

Clients can create and customize non-system generated e-mails using the communication 

functionality in KRB. 

All the communication modules will accept the user signature tokens when generating 

communications based on letters, blurbs, e-mail, and document templates. 

KRB users can: 

⬧   use merge tokens to uniquely identify the Recruiter and User Signatures contained within 

outgoing correspondence. 

⬧  use the Signature field in the user profile for each KRB user. The company information 

can vary by user based on which division/subsidiary they work within. 

Cost 

There is no additional cost associated with this feature. 

Date Available 

This feature is available in KRB 11.5, Build 4 on March 10, 2009. 

How Do I Get this Feature? 

Please contact your Kenexa consultant for assistance with the client setting. Your Certified 

Workbench User can ensure that the correct user type privileges are enabled for users (this is 

probably already done), and your templates manager(s) can incorporate the signature tokens 

into e-mail templates as necessary. 

Details, Limitations, and Known Issues 
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With this release the tokens will not be rendered for templates configured for Automation 

Manager. 

Configuration 

Workbench 

Kenexa personnel: Set the User Signature setting to Yes. 

Workbench/Workbench Self-Service 

Kenexa personnel or Certified Workbench Users: Enable the following Communications 

privileges for each user type as appropriate: Add  / Edit / Enable  / Administer for all 

correspondence types (letters, blurbs, e-mails, and documents). 

KRB Admin+ 

Templates Manager: Once the feature is enabled, configure blurbs, and letter, e-mail, and 

document templates with Recruiter User and User Signature tokens as required for your 

organization. 

The tokens are: 

⬧  User Signature (User Profile merge field)-Display name[#User-Info:Signature#] 

⬧  Recruiter User Signature (Req Standard merge field)-Display name 

[#RequisitionStd:RecruiterUserSignature#] 

  

  



8 

©Kenexa 2002 – 2008 

Data Insight Tool 

The Data Insight Tool provides: 

⬧  Complete control over data filtering and output customization 

⬧  User-centered design allows you to see what you’re building as you build it 

⬧  Enhanced security features with user role management 

⬧  Easy report distribution 

Benefits 

Your organization has maximum flexibility to create and schedule report templates to 
extract data, while maintaining data privacy and security by granting user role 
access. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available to be turned on in KRB 12 on April 23, 2009. 

How Do I Get this Feature? 

Please contact your Kenexa consultant for help with enablement. 

Details, Limitations, and Known Issues 

To Kenexa personnel:There are three issues which came up in testing in which data 
might display unexpectedly. Please refer to QC Defect #129544 if you have any 
questions. 

1.    You can associate questions from many different sources with Talent Gateways. 
In some rare cases, a Basic Talent Gateway does not have any questions 
associated with it. 

If you create an Insight template with the Gateway Submission filter set to No (as 
shown in Figure 1 below): 

  

  

Figure 1: Gateway Submission filter criterion is “No” 
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… and your organization has one or more Basic Talent Gateways with no associated 
questions, your job results will list that Basic Talent Gateway unexpectedly in the 
How Received column of the report: 

 

 

Figure 2: BTW with no questions displays in How Received column unexpectedly 
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2.    When a candidate submission that came in originally as a req-specific 
submission was moved manually to a Req folder or Working folder, this resulted 
in some expected data not showing up in the report. 

If an Insight user selects the following filter and filter criterion, Gateway Submission 
= No, and selects the following output fields: Site name, Site type, Candidate type, 
How received, Code, and Code type added as output, these fields will be blank in 
the job report because: 

The candidate’s connection to the requisition was severed, as was the candidate’s 
connection to several other fields – Site name, Site type, Candidate type, How 
received, Code, and Code type added; and 

The system does not recognize the candidate’s connection to the Req or Working 
folder to which he or she was manually filed. 

3.    If candidates are filed to Working folders or the Inbox, the expected result is that 
the report should display BOTH Gateway submission candidates and non-
gateway submission candidates. However, the Site name, Site type, How 
received, Candidate type, Code, and Code type are blank, and Gateway 
submission and Job submission are displayed as No because the candidates 
were filed to Working folders or the Inbox. The Date applied displays the date 
when the candidate was filed to the Working folder or Inbox. Note: If Req 
folder(s) are selected as output instead of Working folders or Inbox, then Site 
name, Site type, How received, and Gateway submission are displayed. 
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Visible Changes 

There are no visible changes associated with this feature without configuration. 

Configuration 

This section describes the major steps for enabling the Data Insight Tool and setting 
up both administrator and non-administrator user access to it. 

The major steps are: 

1.    Kenexa personnel: In Workbench, enable the client settings. 

2.    Kenexa personnel or Certified Workbench User:In Workbench, enable the setting 
Data Insight Tool access for Administrator under Administer type 
preferences for the KRB user type who will be the Data Insight Tool default 
Admin user. 

3.    Kenexa personnel or Insight Admin user:Create user roles in the Data Insight 
Tool. 

a)    Create additional administrator user roles if necessary. 

b)    Create other user roles. 

4.    Kenexa personnel or Certified Workbench User:In Workbench, enable the setting 
Data Insight Tool access for Administrator under Administer type 
preferences for additional KRB user type(s) who will have corresponding 
administrator user roles in the Data Insight Tool, if applicable to your setting. 

5.    Kenexa personnel or Certified Workbench User: In Workbench, enable the 
setting enable Data Insight Tool access for User (Non-administrator) under 
Administer type preferences for additional KRB user type(s) who will have 
corresponding user roles in the Data Insight Tool, if applicable to your 
organization. 

Enabling the Client Settings 

Who does this: Kenexa personnel 

1.    In Workbench, select Admin > Manage clients > Search for client > Edit client 
settings. 

2.    Scroll to the Restricted Settings section. 

3.    Set the radio button for Data Insight Tool to Yes. 

4.    Enter the Data Insight Tool URL. Note: The Kenexa consultant sets the URL on 
a one-time basis to enable Phoenix access. Kenexa Engineering defines the URL 
for specific environments. 
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5.    Click Save. 

6.    The Data Insight Tool option is enabled in: 

−        Tools > Users > User Type > Administer Type Preferences 

Configuring Insight Access the Insight Admin User 

Who does this: Kenexa personnel or Certified Workbench User 

Important:Once you assign a KRB User Type to the default Data Insight Tool Admin 
Role in Workbench, you cannot disable the Data Insight Tool client setting. 

To configure preferences for the Insight Admin user for the first time: 

1.    In Workbench, select Tools > Users > User Types. 

2.    In Workbench, on the User types page, click the Administer Type Preferences 
icon for the same user type. 

3.    At the bottom of the Preferences window, enable Data Insight Tool access for 
Administrator. 

4.    Click Save. 

Creating User Roles in the Data Insight Tool 

Who does this: Kenexa personnel or Insight Admin User 

As the default Admin for Insight, you should be able to access the Data Insight Tool 
from within Kenexa Recruiter BrassRing (KRB) once Insight has been enabled for 
your organization and for your KRB user type. 

Your next step is to create user roles within the Data Insight Tool before you can 
enable access for additional Insight users. (You can create dummy user roles in 
Insight and configure their details later.) 

Once the additional user roles have been created in the Data Insight Tool, you must 
go back to Workbench to configure Type Preferences for each Insight user role you 
created. This step essentially maps the Insight user role to the KRB user type 

A Data Insight Tool user role definition specifies the functional areas of the KRB 
database to which the role is restricted. By default, the administrator role has access 
to all areas of the database. 

To access Insight and create user roles: 

1.    In KRB, select Reports > Data Insight Tool > Manage users and roles. 

2.    In the User Role Library, click Create New Role. 
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3.    Specify the name and description, and click Next >. 

4.    In the User Role Workshop: 

a)    Use the Restriction Selection Tool to select the items to which you want to 
restrict access for this user role. Add them to the worksheet. (See page 12 for 
more information.) 

c)    For each item, select criteria in the Restrictions Worksheet to restrict access 
more specifically. (See page 12 for more information.) 

For example, if you select the item "Req Status" listed under "Requisition," you must 
select specific req statuses as criteria in the Restrictions Worksheet. 

5.    When you are finished, click Next >. The User Role Summary displays. 

6.    Review the User Role Summary. Go back to make changes if desired. 

7.    Save the user role. Print the User Role Summary if desired. 

8.    Insight adds the user role to the User Role Library. 

9.    Repeat this procedure for each Insight user role you wish to create. 

Selecting Functional Area Restrictions 

In the User Role Workshop, you select the combination of functional areas and 
criteria to which the user role has access. For a single user role, you can select a 
maximum of 10 functional area restrictions and up to 50 criteria per restriction. See 
the Insight Selection Tool Field List document (included in the R12 Documentation 
Bundle or the Insight Documentation Bundle) for detailed information on restrictions. 

Custom items within functional areas are listed in alphabetical order (123/abc). 

⬧  You can select a maximum of 10 functional areas as restrictions. 

⬧  You can select a single functional area once only. 

⬧  You can add 1 or several functional area restrictions at the same time. 

To select functional areas for restriction: 

1.    Click the plus sign beside each functional area to display the list of items. 

2.    Select up to 10 items. 

3.    Click Add to Worksheet. 

To select the items to which the user role will be restricted: 
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1.    In the Selection Tool, expand the functional areas and select the items that you 
want to restrict. 

2.    Click Add to Worksheet. 

3.    Insight adds your selections to the Restrictions Worksheet. Each restriction has 
its own column. 

Selecting Criteria for Functional Area Restrictions 

⬧  You must select criteria for each restriction added to the worksheet (except for My 
Reqs and My Working Folders). 

⬧  You do not need to select criteria for My Reqs and My Working Folders. 

⬧  You can select criteria that are stored in the following field types: Text field, 
Numeric value, Date, Date and Time, Multi-select List, Yes / No Boolean, and 
Status. 

⬧  You can select a maximum of 50 criteria for each restriction. 

To select restriction criteria: 

1.    In the Restrictions Worksheet, click the green arrow in the Accessible Data row to 
view the selections available for each functional area. 

2.    The selection method depends on the data type of the criteria: Text field, 
Numeric value, Date, Date and Time, Multi-select List, Yes / No Boolean and 
Status. 

3.    Once you have selected the restriction criteria, click Save to add the selection to 
the Restrictions Worksheet. 

4.    Click Next > when you are finished selecting and adding restrictions to the 
worksheet. 

For example, if you wanted to know what requisitions were viewed by a certain HR 
Manager within a specified time period, select Requisitions as one of your functional 
areas, and select Requisition Number as the criteria for that functional area. (You 
would also select Viewed by and Viewed on as two more of your functional area 
restrictions.) 

Figure 3: Filter Data Types 

Filter’s 
Data 
Type 

  

Examples 

  

Your Action 
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Text field City, 
Candidate 
Name 

Enter up to 255 characters in the text box. It accepts 
the following characters in any order: 

⬧  Alphabet 

⬧  Numbers 

⬧  Unicode 

⬧  Special Characters (except for those listed below) 

⬧  Spaces in between text (but not leading and trailing 
spaces) 

 

    You cannot use: 

⬧  Wildcards (for example, * or &) 

⬧  HTML tags (such as < and >) 

⬧  Programming script or code 

⬧  Leading and trailing spaces in the text box  (   HR 
status change  ) (Note: You can include spaces 
between the words, just not before and after the 
entire name.) 

 

    You cannot use: 

⬧  Wildcards (for example, * or &) 

⬧  HTML tags (such as < and >) 

⬧  Programming script or code 

⬧  Leading and trailing spaces in the text box  (   HR 
status change  ) (Note: You can include spaces 
between the words, just not before and after the 
entire name.) 

 

    ⬧  The following special characters: 

−        ampersand & (because they are reserved for 
wildcards in other areas of the application) 

−        asterisk * (because they are reserved for 
wildcards in other areas of the application) 

−        colon : 

−        question mark ? 
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−        back slash \ 

−        vertical bar | 

−        forward slash / 

    Note: Case does not matter: Search terms can be in 
uppercase, lowercase, or mixed case, including for 
"Exact match" search. 

⬧  To search for a string of characters, use the Contains 
search (the default setting). For example, enter 
"able" to search for a candidate whose name 
contains the letters "able" anywhere in the first or 
last name. The search would return names 
like  "Ablett," and "Huxtable." 

⬧  To search for the beginning of a term, select Starts 
with and enter the first one or more letters of the 
term. 

 

    To search for the beginning of a term, select Starts 
with and enter the first one or more letters of the term. 

Note: Case does not matter: Search terms can be in 
uppercase, lowercase, or mixed case, including for 
"Exact match" search. 

To search for a string of characters, use the Contains 
search (the default setting). For example, enter "able" 
to search for a candidate whose name contains the 
letters "able" anywhere in the first or last name. The 
search would return names like  "Ablett," and 
"Huxtable." 

To search for the beginning of a term, select Starts 
with and enter the first one or more letters of the term. 

To search for a precise term, select Exact match and 
enter the exact term. Note: Case does not matter. 

Click Save. Insight adds the selected criteria to the 
worksheet. 

 

Date 
option 

Date 
approved, 
Date 
closed 

Select a date option.   

Yesterday is the default setting. 

Exact date - is not a rolling date 

Date range 
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- is not a rolling date. 

- Begin date must be earlier than end date. 

- Begin date and End dates are inclusive. 

- You can select the current year, plus 3 years forward 
and back. 

Date and 
Time 
option 

Date/time 
of 
interview, 
Date/time 
of request 
for 
interview 

Select a time option. 

All times is the default setting. 

Exact time - is not a rolling time. 

Time range 

- is not a rolling time. 

- Begin time must be earlier than end time. 

- Times are inclusive. 

 

Multi-
select list 

User name Select or search for and select items in the Available 
list box. 

Displays the top 200 options by default. 

Click the double right arrows to move selected items to 
the Selected list box. 

 

Yes / No 
Boolean 

Approvals 
process 

Radio button: Yes / No  

Numeric 
value 

Target 
score 

Enter or search for an integer value (maximum of 9 
digits)  or range of integer values using the following 
arithmetic operators: 

=     Equals 

<>   Less than or Greater than 

<     Less than 

 >    Greater than 

 <=  Less than or Equal to 

 >=  Greater than or Equal to 

 

Status Working 
folders 

Select Active (the default setting) or Inactive. This 
status applies only to Working folders.  
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Note: This filter does not refer to the status of Insight 
users, as listed on the User Roster. 

Reviewing and Saving the Role Summary 

The Role Summary displays all of the attributes for the user role you are creating. 
From the summary, you can identify selections to be changed and go back and 
make changes. 

Click Save when you are finished. The role is saved in the User Role Library. 

Configuring Insight Access for Other Users 

Use the same procedure as in the previous section to add additional administrative 
users who have different KRB user types. 

Configuring Insight Access for Other Administrative Users 

Who does this: Kenexa personnel or Certified Workbench User 

To configure preferences for other Insight administrative users for the first time: 

1.    In Workbench, select Tools > Users > User Types. 

2.    In Workbench, on the User types page, click the Administer Type Preferences 
icon for a different KRB user type. 

3.    At the bottom of the Preferences window, enable Data Insight Tool access for 
Administrator. 

4.    Click Save. 

5.    Repeat this for each additional type of administrative user. 

Configuring Insight Access for Regular Insight Users 

To configure Insight access for regular (non-administrative) users: 

1.    In Workbench, select Tools > Users > User Types. 

2.    In Workbench, on the User types page, click the Administer Type Preferences 
icon for the the KRB user type which corresponds to an Insight user role. 

3.    At the bottom of the Preferences window, enable Data Insight Tool access for 
User (Non-administrator). 

4.    Select one or more user roles from the <Select Role> list. 

5.    Click Save. 
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Viewing the User Roster in Insight 

Once you have performed the procedures described in the previous sections, the 
User Roster of your instance of the Data Insight Tool will be populated with active 
Insight users, each of whom is assigned to an Insight User Role mapped to a KRB 
user type. 

Adding Individual Users to Insight 

In some cases, you may find you want to grant access privileges to an individual 
user rather than granting them to all users of a certain user type. 

You can activate any KRB system user directly from within the Data Insight Tool. 

When you use this method to add a user, the Data Insight Tool implicitly knows the 
user’s user type. However, the User Roster displays “n/a” in the KRB User Type 
column for that user. 

Data Insight Tool Preview 

This section provides a brief preview of the Data Insight Tool. 

Figure 4: Managing Templates 

 

Figure 5: Template Workshop 
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Figure 6: Scheduling Templates 

 

Figure 7: Creating the Notification Message 
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Figure 8: Report Output (This report uses an attached Excel macro.) 

 

  

Data Insight Tool Documentation 

These documents will be included in R12 Documentation bundle for Kenexa 
personnel. Some of the content included in this document is captured in separate 
documents and posted on the R12 internal launch site on the R12 Enablement 
Documents page (at 
http://www.kenexanet.com/sites/plp/KRB12/R12%20Enablement%20Documents/For
ms/AllItems.aspx): 
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Data Insight Tool Templates Help 

Data Insight Tool User Management Help 

Insight Selection Tool Field List 

Adding Users to the Insight (Internal Use Only) 
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Partners - 2 New Posting Options Using TMP Pathways 

Note: This information is partial. I will update it when more is available. 

Kenexa has partnered with TMP Pathways to provide two new posting options: 

⬧  TMP Pathways Enterprise Edition for customers who post between 1K to 10K requisitions 

per year 

⬧  Kenexa Job Distributor powered by TMP Pathways for customers who post more than 500 

reqs per year 

TMP Pathways Enterprise Edition provides: 

⬧  Unlimited access to TMP’s broad suite of job sites 

⬧  Posting capabilities to both automated and manual job sites 

⬧  Results-driven posting recommendations with TMP inSite 

⬧  “What’s-my-Buzz” and “What’s-my-Ranking” brand monitoring utilities 

⬧  Email Center and Focus Search modules for marketing management 

⬧  Job site membership and inventory management tools 

Kenexa Job Distributor provides: 

⬧  Supports up to 500 transaction per year 

⬧  Clients can select up to 10 job posting sites 

⬧  Posting capabilities are to automated job sites only [did I get the right meaning?] 

⬧  Provides site membership and inventory management tools 

⬧  Clients can migrate up to TMP Pathways Enterprise Edition 

 

 

  

Table 5: TMP Product Features 

  Kenexa Job 

Distributor 

TMP 

Pathways 
 

Membership management Yes Yes  
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Company hierarchy match Yes Yes  

Recommendation engine No Yes  

Quick-post Yes Yes  

Full global support Yes Yes  

Buzz & Ranking Yes Yes  

Search Focus Yes Yes  

Email Center Yes Yes  

Metrics Gateway Yes Yes  

Domestic board access 
Select (10 – 

prepaid) 
All  

International board access 
Part of (10 – 

prepaid) 
All  

Posting to manual boards No All  

Benefits 

The Kenexa-TMP alliance provides: 

⬧  Distribution to social networking sites 

⬧  Robust sourcing metrics for cost/benefit analysis 

⬧  Product support by TMP through the standard Kenexa process 

⬧  Job distribution to 465 domestic sites,120 international sites and 245 manual sites 

Cost 

⬧  TMP Pathways Enterprise Edition for customers who post between 1K to 10K requisitions 

per year 

−        Customers negotiate one agreement directly with TMP 

−        Kenexa does not charge any connector and/or maintenance fees 

⬧  Kenexa Job Distributor powered by TMP Pathways for customers who post < 500 reqs per 

year 

−        Annual fees are based on company size 
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−        Feature is powered by TMP technology 

Date Available 

How Do I Get this Feature? 

Please contact your Kenexa consultant for more information. 

Details, Limitations, and Known Issues 

Apply URL link and creation process – PM and the Development team need to determine the 

best way to provide the apply URL link information to TMP.  Several options include: 

⬧  Requiring the recruiter to manually enter the URL 

⬧  Adding a URL field to the Requisition form 

⬧  Auto create based on the Talent Gateway selection. 

State of the “posted” icon once the requisition is sent to TMP.  Choices include: 

⬧  A new definition for the existing icon 

⬧  Creation of a new icon to indicate that it was sent to a distributor 

⬧  Do not change the icon state since we do not know if it was actually posted. 

⬧  Return feed from TMP on which sites each requisition was posted to.  TMP is working on 

this functionality.  Will most likely be implemented in second revision of the interface. 

Visible Changes 

There are no visible changes associated with this offering. 

Configuration 

Kenexa personnel or your Certified Workbench User maps your organization’s requisition to 

KRB standard and custom req fields. The KRB standard and custom req fields are then 

mapped to TMP Pathways fields. 

Workbench 

1.       Kenexa personnel or Certified Workbench Users: When adding a new req form or 

editing an existing req form, configure the Posting interface mapping settings for each 

field to be mapped. 

Figure 77: Configure the Posting interface mapping for each field 
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Here is an example of a completed field mapping for a requisition. [Where does this table 

come from? Did Bob create it for illustrative purposes, or is it generated once all the field 

mappings are completed?] 

Figure 78: Field Mapping Detail 

 

Does this step actually refer to how you get the fields into KRB? 
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Configure req fields using the standard configuration process so that the client’s system can 

pass the Job Category to TMP: 

1.       Create a custom requisition field from selection (for example, TMPCAT) 

2.       Import the following options manually or using the spreadsheet load method. 

Figure 79: 

 

3.       Include the defined field in the requisition template 

4.       Create requisition using the template 

If a job category is not provided in the requisition, the client will be prompted for it during 

the transfer procedure to TMP.  When the text provided does not match the predefine TMP 

categories, the client will then be required to select the appropriate job category from a list on 

the Pathways posting screen. 

Account Setup in KRB 

After purchasing either Kenexa Job Distributor or TMP Pathways suite, the client’s Kenexa 

consultant and a designated TMP representative help them complete the onboarding 

process.  During this process the client receives their TMP account information. 
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After Workbench configuration is complete, Kenexa personnel or the KRB Administrator 

must configure the Posting interface defaults in KRB with the TMP account information. 

1.       In KRB, select Admin > Posting interface defaults. 

2.       Click the Edit account icon for Kenexa Job Distributor / TMP Pathways. 

Figure 80: Posting interface defaults menu option in KRB 

 

3.       Enter your login information. The user will select the edit account icon to access the 

entry window.  Their account information van not be entered and saved.  Each time the 

user accesses TMP the system will pass the required login information. 

4.       Enter the client’s TMP account information. 

5.       Click Save. 

Figure 81: Edit account 
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Once the client’s account is set up in KRB, Kenexa or the TMP performs several 

configuration steps within TMP pathways. See the next section, “Kenexa Job Distributor 

Account Set-up” on page 117. 

 [Will there be a section for the TMP Pathways Enterprise Edition?] 

Kenexa Job Distributor Account Set-up 

The following TMP Account set-up process must be completed by all Kenexa Job Distributor 

customers with the assistance from their Kenexa Client Services Consultant: Basic 

information, Group instruction, User Instruction, User List, Job Boards, Buzz, Ranking, and 

Tracer Tags. 

Figure 82: Account Set-Up Form 
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Please see the next several screen captures for examples of each account set-up tab. 

Figure 83: Basic Information 

 

Figure 84: Group Instruction 
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Figure 85: User Instruction 

  

Figure 86: User List 
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Figure 87: Job Boards 

  

Figure 88: Buzz 
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Figure 89: Ranking 
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Adding Tracer Tags to HTML Pages 

A Tracer Tag is an invisible 1px gif embedded in apply pages and other destination pages at 

implementation time. Tracer tags provide the capability to do metrics reporting for clients. 

Metrics reporting includes impressions, views, click data, post-impression data, and so forth, 

which can then be used to develop trends and analysis that enable clients to gauge job board 

effectiveness, cost per lead, cost per applicant and cost per conversion. ROI tracking is also 

available. 

Who is configuring the tracer tags and where are they doing it? 

Here is an example of the mark-up for a tracer tag: 

<img src   =“https://s0.hrtrak.com/ix.e?bb&t=9999” width=1 height=1 border=0> 

Tracer Tag Placement 

⬧  The Tracer Tag must be placed within the body of the page.  

⬧  The Tracer Tag cannot be placed in the head of the page, or outside of the <HTML> tags.  
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⬧  The Tracer Tag cannot be placed inside a table. 

⬧  You can add more than one tracer tag to an HTML page. 

Testing Tracer Tag Implementation 

To test the implementation of the tracer tag: 

1.       Visit the site page where the Tracer Tag should be implemented. 

2.       View the source code of the page. For example, in Internet Explorer, use the View tab 

and select Source from the menu, or right-click and select View Source. These 

instructions need fixing. 

a)      In the source page, use the Search tab and click Find in the menu. 

b)      In the find box, type in “hrtrak” and click the Find Next button until you see the 

Tracer code. 

c)       Confirm that the Tracer id is the same as the id intended for that page. The Tracer id 

is highlighted in blue and looks similar to the following example: 

<img src=“http://s0b.hrtrak.com/ix.e?bb&t=9999” width=1 height=1 border=0> 

d)      Confirm that the code is inside the <body></body> tags and not within the 

<head></head> or table <table></table> tags. 

User Experience 

This section describes the user experience for posting a req when using this feature. 

1.       Navigate to the listing page for open reqs. 

Figure 90: Open reqs page 
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2.       Find the req to be posted and click Posting options. 

Figure 91: Edit posting options page 

 

3.       Select the posting option (your selection depends on your individual user account): 

Kenexa Job Distributor, TMP Pathways, or the other posting options. 

4.       The req displays in the Launch to posting partner window. It is populated with the req 

information. (This is current functionality.) 

5.       You can edit the fields as needed and submit the req. 

6.       The TMP Pathways site displays. 

Figure 92: Posting through TMP pathways 

 

7.       Select your posting sites. 

Figure 93: TMP Pathways Posting Site Selection 
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Note: If your organization purchased Kenexa Job Distributor, you will see a posting page 

similar to the one above with this logo: 

Figure 94: New Kenexa Job Distributor Logo 
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Recruiter Experience - 3 Ways to Access Req Approval 

eLinks 

KRB users using the req approvals process on mobile devices have three ways to access the 

eLinked req from their mobile device. (Please see the “Details, Limitations, and Known 

Issues” section on page 81 for information about configuring the environment for mobile 

devices.) 

As a user of “Mobile Device Approvals,” you receive an automatically-generated e-mail 

through your mobile device asking you to view the details of a req and approve it. 

If the new client setting described below is enabled, two links are displayed in the e-mail: 

⬧  the standard link View Requisition Details 

⬧  the http address link; for example: https://trmx-

staging.brassring.com/MobileApproval.UserInterface/ReqApproval.aspx?g=B0EA3C3211B94102A700AB276AF
BE6E5&c=nEErLCr$rvJo8/VAc3OuNQ= 

In addition, the e-mail includes a message telling you to copy and paste the http address link 

into the browser address bar if clicking at least one of the links directly within the e-mail does 

not work. 

How It Worked Before 

On the mobile device (such as a Blackberry) the eLink to the req (View Requisition Details) was 

not always active and clickable by users. There was no other way to access the req from the 

mobile device in order to view and approve. 

Benefits 

You have three ways to reach the eLinked content from your mobile device; at least one of 

them should work! 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 2 on January 29, 2009. 

How Do I Get this Feature? 

To use this new capability for Mobile Device Approvals, your Kenexa Consultant must 

enable the new client setting in Workbench. 

Details, Limitations, and Known Issues 

https://trmx-staging.brassring.com/MobileApproval.UserInterface/ReqApproval.aspx?g=B0EA3C3211B94102A700AB276AFBE6E5&c=nEErLCr$rvJo8/VAc3OuNQ
https://trmx-staging.brassring.com/MobileApproval.UserInterface/ReqApproval.aspx?g=B0EA3C3211B94102A700AB276AFBE6E5&c=nEErLCr$rvJo8/VAc3OuNQ
https://trmx-staging.brassring.com/MobileApproval.UserInterface/ReqApproval.aspx?g=B0EA3C3211B94102A700AB276AFBE6E5&c=nEErLCr$rvJo8/VAc3OuNQ
https://trmx-staging.brassring.com/MobileApproval.UserInterface/ReqApproval.aspx?g=B0EA3C3211B94102A700AB276AFBE6E5&c=nEErLCr$rvJo8/VAc3OuNQ==
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Because our clients’ environments are so variable, Kenexa is unable to test all configurations 

for all mobile devices. Clients using Blackberry® Enterprise Server (BES) for their e-mail 

client must update their BES environment to Version 4.1, Service Pack 6 or later. This 

version and service pack supports HTML and rich-content e-mail messages for BlackBerry 

devices. This feature is turned on by default. Blackberry devices must be running the 

Blackberry® Device Software version 4.5 or later. 

Clients using Lotus Notes as their e-mail client must have IBM® Lotus® Domino® version 

7.0.2 or later to support rich-content email messages on the BlackBerry Enterprise Server. 

Visible Changes 

There are no visible changes in Mobile Devices without configuration. 

You can see the changes associated with this enhancement in the following locations: 

⬧  Workbench (Internal): On the Edit client settings page, there is a new client setting eLink approval - 

Display hyperlink and text. 

⬧  Within the KRB req approval process on mobile devices: Once the client setting is turned on, the e-

mail content generated for req approvals on mobile devices contains additional ways to 

access the eLinked req. Please see the description on page 43. 

Configuration 

Kenexa Consultants: In Workbench, set the new client setting eLink approval - Display hyperlink 

and text to Yes. When this setting is enabled, mobile device users will be able to see both the 

standard View Requisition Details link, the hyperlinked http address for the req, and the 

instruction to copy and paste the http address URL into the browser in the automatically-

generated email requesting approval for the req. 

Figure 59: “eLink approval - Display hyperlink and text” client setting in Workbench 
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User Experience 

For KRB users who use the mobile device approval capability, the automatically-generated e-

mail message inviting you to review and approve a req has the format shown in Figure 60 

below. 

Figure 60: Approval message for mobile devices 

 

On your mobile device, the e-mail message provides three methods for accessing the eLinked 

requisition: 

1.      The standard link: View Requisition Details. 

2.      The actual http address link. Here is an example: 

https://trmx-
staging.brassring.com/MobileApproval.UserInterface/ReqApproval.aspx?g=B0EA3C3211B94102A700AB276AF
BE6E5&c=nEErLCr$rvJo8/VAc3OuNQ= 

https://trmx-staging.brassring.com/MobileApproval.UserInterface/ReqApproval.aspx?g=B0EA3C3211B94102A700AB276AFBE6E5&c=nEErLCr$rvJo8/VAc3OuNQ
https://trmx-staging.brassring.com/MobileApproval.UserInterface/ReqApproval.aspx?g=B0EA3C3211B94102A700AB276AFBE6E5&c=nEErLCr$rvJo8/VAc3OuNQ
https://trmx-staging.brassring.com/MobileApproval.UserInterface/ReqApproval.aspx?g=B0EA3C3211B94102A700AB276AFBE6E5&c=nEErLCr$rvJo8/VAc3OuNQ
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3.      If clicking the first or second link does not work, copy the HTTP address link (as in 2 

above) and paste it into the browser’s address bar, as shown in Figure 61 below. Important: 

Copy the entire HTTP address, including any characters as the end such as the = sign. 

Figure 61: http address copied into browser’s address bar 
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Recruiter Experience - Automatically Set to HR Status to 

First Step in Workflow 

Your organization can elect to have a candidate’s HR status automatically set to a pre-defined 

HR status (from the “start” statuses defined in your tracking logic) when the candidate 

applies to a job and is filed to a req folder through insta-filing. 

This capability is configured at the level of the req form (also called the “req template”). By 

default, when a candidate is insta-filed to a req folder, the candidate’s HR status does not 

change. When this new setting is configured for the req form, candidates who are insta-filed 

to reqs using that form are automatically set to the specified HR status. 

Your organization can select different insta-file HR statuses for different req forms. For 

example, you might want candidates filed to reqs using one type of form to move to an HR 

status called “Assessment,” but want candidates filed to reqs using another type of req form 

to move to an HR status called “Initial Screening.” 

You can also change the insta-filed HR status for a req form at a later time. 

How It Worked Before 

Previously, your only choice was the default behavior: As soon as the candidate applies, the 

status is set to 0-filed. 

Business Need 

If your organization does not use the 0-filed status, and/or wants candidates to be insta-filed 

automatically to one or several designated “start” HR statuses, you might be interested in this 

feature. 

Benefits 

The feature reduces the manual processing of candidates and speeds up the response time to 

candidates. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 2, on January 29, 2009. 

How Do I Get this Feature? 

Your Kenexa consultant must configure the new setting for req form(s) in Workbench when 

configuring new req forms. Your Certified Workbench User can edit this setting in existing 

req forms. 
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Best Practices 

If you use more than one req form, determine for each req form whether you want to enable 

this feature and which is the appropriate “start” HR status after insta-filing to req folders. 

Details, Limitations, and Known Issues 

Caution: Modifying your organization’s Insta-file behavior can affect custom reports if your 

organization currently reports on 0-Filed date and decides to stop using 0-Filed.  The CSC 

should check with Professional Services for impact on custom reports before the setting is 

turned on. 

When configuring this new setting, you can select only from among your organization’s 

designated “start” HR statuses (and not from designated intermediate or final statuses, set up 

for tracking logic). 

If you change the insta-file HR status for an existing req form, it affects only those candidates 

who are filed to reqs using that form after you make the change. Candidates who have 

already been filed to a req using a req form with the previous HR status are not affected. 

This feature works with both open and closed tracking logic. 

There is no change to the system-generated insta-file e-mail sent to candidates overnight. 

This feature does not affect the existing req form setting Auto-send email to candidates in req folder 

by HR status; this setting works as it did in past releases. 

If Kenexa personnel or a Certified Workbench User tries to inactivate an HR status that is 

being used as the insta-file HR status on a req form, the following error message is displayed: 

“This HR Status cannot be inactivated since it has been configured for Automatic filing on at 

least one Req Form. Inactivate button on the inactivate HR status form will be deactivated.” 

This feature works for candidate submissions through Talent Gateways and Agency 

Managers, and for candidates coming in through Candidate Import. 

Interaction with Automation Manager trigger: If your organization uses Automation Manager and 

enables the HR Status Update – notify candidate trigger, a notification is sent to the candidate based 

on the HR “start” status selected in this feature. 

This feature does not affect Req import or Autofiling. 

Visible Changes 

There are no visible changes in KRB without configuration. 

Workbench [Internal Use Only] 

Kenexa personnel see the new setting on the Add New Req Form and Edit req form pages. 
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If Kenexa personnel or Certified Workbench Users try to inactivate an HR status which was 

selected as the insta-file HR status for a req form, the following error message displays: 

“This HR Status cannot be inactivated since it has been configured for Automatic filing on at 

least one Req Form” 

To view this message: 

1.      In Workbench, select Tools > Tracking logic > HR status. 

Figure 30: Status Administration – Inactivating HR statuses enabled on req forms 

 

2.      Find the designated insta-file HR status you want to inactivate (for example, Active, Start 

Status). 

3.      Click the icon in the Activate/Inactivate column. 

4.      Workbench displays the error message as shown in Error! Reference source not found. 

below: 

Figure 31: Inactivate HR status error message 
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5.      Click Cancel to close the window. 

Workbench (Self-Service) 

Certified Workbench Users see the new setting on the Edit req form page. 

Certified Workbench Users see the error message if they try to inactivate an HR status that is 

tied to a req form on the Tools > Tracking logic > HR status page. 

Configuration 

The goal is to configure the insta-file HR status for each req form in your organization (new 

and existing). 

1.       Kenexa personnel: Ensure that your organization has configured HR “start” statuses for 

tracking logic (WB > Tracking logic > HR status > Add start status). Note: This feature works with 

both open and closed tracking logic. 

2.      Kenexa personnel: For each Talent Gateway, set the Filing option setting to Insta-file. (WB > 

Talent Gateway > Admin > Add/Edit a gateway). 

3.      Kenexa personnel: Configure the insta-file HR status for each req form: 

a)      In Workbench, select Tools > Forms > Reqs > Req forms. 
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a)      When adding a new req form, click Add new req form in the Actions menu. Note: If you 

partially finish configuring a req form and save it as a draft, it does not affect how this feature 

works. Once the req form is in use, the feature works as expected. 

When editing an existing req form, find the req form you want to edit and click the Edit icon 

in the grid. 

b)      Select the desired insta-file HR status from the list for Automatically file candidate to Req folder 

by HR Status through insta-file in the Add New Req Form/Edit req form page, as shown in Error! 

Reference source not found.: 

User Experience 

Kenexa Recruiter BrassRing 

There are no visible changes without configuration. 

Once this feature is configured, the process for adding or editing a req in KRB is not 

changed. However, insta-filed candidate submissions are set immediately to the “start” HR 

status configured in Workbench for the requisition’s underlying req form. 

Talent Gateways and Agency Managers 

When this feature is enabled, candidate submissions are filed instantly to req folders and the 

candidate’s HR status is set automatically to the designated insta-filing HR start status. 

Figure 32: Add New Req Form 
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Recruiter Experience - Candidate Action View Notes 

Privilege 

Non-system users who receive eLinks have the Quickstart user type. With this enhancement, 

when non-system users receive an eLink, the system checks the “Notes” user privileges of the 

Quickstart user type and either displays or hides notes depending on the settings for those 

privileges. 

How It Worked Before 

Prior to this change, the recruiter would send a non-system user an eLink with notes attached 

but was unaware that user could view the notes.  The system was checking the sender’s 

privilege but not the recipient’s privilege. 

Benefits 

This enhancement ensures that non-system users see or do not see notes, as indicated by their 

user type privileges. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 3 on February 19, 2009. 

How Do I Get this Feature? 

This enhancement is available automatically in KRB for users working in this scenario with 

the appropriate user type privileges. 

Visible Changes 

When a recruiter sends an eLink (with notes attached) to a non-system user, the recipient 

user’s privileges are checked before the eLink is sent. The eLink recipient users’ ability to 

view notes attached to eLinks is now based on their user type privileges, as shown in Figure 

53. 

 Figure 53: Notes user type privileges 
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Recruiter Experience - Candidate Forms Language 

Display 

Forms and “outputable” form fields that have been selected as output fields on Candidate, 

Req, Req folder, Working folder, and Inbox grids display in the language in which they were 

created (the user’s language). 

The language of the data in these form fields is the same as the user language in the relevant 

listing grid if the forms have been translated previously into the user’s language; otherwise, 

the forms and form fields are in your organization’s Base language. 

How It Worked Before 

The KRB user who was logged in as a Spanish user working for an organization whose Base 

Language was also Spanish, expected to see candidate form fields in Spanish when selecting 

form fields as output fields for candidate grids (since the candidate form had been created in 

Spanish, completed in Spanish, and submitted through a Spanish Talent Gateway). However, 

the form fields were in English when the KRB user tried to select them as output fields for 

candidate grids. 

Benefits 

KRB users see and use candidate forms and form fields in the language in which they were 

intended to be seen and used. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 3 on February 19, 2009. 

How Do I Get this Feature? 

This feature is available without configuration. 

Details, Limitations, and Known Issues 

If the candidate form was not translated, it displays in the client’s Base Language. 

Visible Changes 

If your organization permits candidates to submit candidate forms in languages other than 

English, you can see visible changes as a result of this update in the following locations in 

Kenexa Recruiter BrassRing: 

⬧  On candidate grids: When candidate forms have been added to the Talent Record, KRB users 

can select individual form fields as output fields on candidate grids. 
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⬧  On views which include the reqs grid: When candidates have submitted an application to a job 

through a Talent Gateway, and the submission includes completed form fields (which have 

the attribute of being outputable), KRB users viewing the req for this submission can select 

form fields derived from that submitted candidate form for the req grid (as long as the form 

field is “outputable”). 

⬧  On the req folder output grid: When KRB users import (both by standard import and via XML) 

a candidate form to a candidate in KRB, and navigate to the req folder in which the candidate 

form now resides, KRB users can select form fields from this form for their req folder output 

grid (as long as the form field is “outputable”). 

⬧  On the Working folders/Inbox output grid: When KRB users have moved or copied a candidate to 

Working folders or the Inbox, KRB users can select form fields derived from the submitted 

candidate form for the Working folders or Inbox grid (as long as the form field is 

“outputable”). 
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Recruiter Experience - Candidate Stacking Logic 

Enhancement 

IMPORTANT: This feature will not be enabled or announced externally in the R12 time frame 

due to some limitations. 

Clients will be able to configure stacking logic to include a client-defined field and customize 

the field’s label. When enabled, a new standard field appears on the Talent Gateway “Contact 

Information” page and on the KRB Talent Record’s Overview tab. 

Three new stacking logic schemas include this client-defined field. 

Details 

The feature was designed so that clients could capture information such as Employee ID. The 

Candidate stacking field can be used in the following places: 

⬧  Autofill field type (as a source for Candidate form Autofill field) 

⬧  Gateway Questionnaires (as a Contact information field widget) 

⬧  Candidate import 

⬧  Talent Profile import 

If the client setting is enabled, the field displays on the KRB Talent Record on the Overview 

tab. 

The feature will be available for Basic and Full Talent Gateways. 

Clients can give the field a custom label. Each Talent Gateway must have the same label. 

Clients can elect to display the field and make it required per Talent Gateway. 

If the field is populated already in KRB, it is not overwritten by a blank if a specific Talent 

Gateway is set up to not display the field or to not make the field required. 

Data validation (6 numeric characters) is enforced in KRB and on Talent Gateway(s) that 

display the field or make it required. 

Kenexa personnel can customize the data validation error message. 

Proposed Phase II 

The proposed Phase II for this project is “Configurable Data Validation on Candidate 

stacking field.” The proposal is to extend the functionality as follows: 

⬧  Encrypt data field in database 
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⬧  Hide field by language and/or user type in KRB Talent Record 

⬧  Candidate Search and/or Candidate Display Grid (Output fields) 

⬧  Data Insight Tool, DEW, or Standard Reports 

⬧  Provide capability to customize the labels of other standard profile fields (This is a 

frequently requested capability.) 

⬧  Communications Module tokens Include field in Candidate Export 

⬧  Agency Manager 

⬧  KRB companion products (CSR, Community Gateways, etc.) 

Benefits 

This feature will give clients more flexibility to configure unique identifiers for stacking logic 

schemas used on Talent Gateways. Through the client-defined field, clients can gather 

additional data along with standard profile field data. 

Cost 

There will be no additional cost for this feature when it is made available to clients. 

Date Available 

This feature is first available internally in R11.5, Build 4 on March 12, 2009. 

How Do I Get this Feature? 

If you have a client that could benefit from Phase II of this project, please contact Janet 

Kubicki in Product Management. It is not client-facing yet. 

Details, Limitations, and Known Issues 

Due to the following limitations and known issues, this feature is not being released to the 

client base at this time 

⬧  Data validation is 6 characters (all numeric, leading zeros permitted) 

⬧  Data are not encrypted 

⬧  Cannot be hidden or non-editable by user type or language 

⬧  Not available for Candidate search and/or candidate display grid (Output fields)  (i.e. not 

included in Verity) 

⬧  Not available for Agency Manager 
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⬧  Not available for KRB companion products (CSR, Community Gateways, etc.) 

⬧  Not available for Letter template tokens 

−        Workaround: Candidate stacking field value can be auto-filled onto a Candidate form to 

be used for letters. 

⬧  Not available for Data Insight Tool, DEW, or Standard reports 

−        Workaround: Candidate stacking field value can be auto-filled onto a candidate form to 

be used for reporting. 

Best Practices 

Kenexa recommends that you do not use this capability for Social Security Numbers (or any 

other National Identifier) because: 

⬧  The field is NOT encrypted. 

⬧  You cannot hide this field or make it non-editable by user type or language. 

Visible Changes 

Workbench [Internal Use Only]: 

⬧  There is a new client setting, Enable Candidate stacking field. 

⬧  There is a new menu under Tools > Settings called Fields. 

−        Several existing sub-menu items have been relocated to the Fields menu: Search fields, 

Search reasons, and Output fields. 

−        There is a new item under the Fields menu: Candidate profile fields. 

Workbench/Workbench Self-Service: There is a new configurable error message. 

KRB: There are no visible changes without configuration. 

Figure 62: New “Fields” sub-menu 
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Configuration 

Workbench 

Kenexa personnel: Set the new client setting Enable Candidate stacking field to Yes. Once this setting 

is enabled, Workbench users can see the 

Tools > Fields > Candidate profile fields > Edit Candidate stacking field. 

Kenexa personnel: Configure the custom label. The custom label displays in KRB Overview and 

in any Talent Gateway that has configured the field to be displayed. 

Kenexa personnel: Configure the data validation error message. 

Figure 63: Candidate profile fields 

 

Figure 64: Candidate Stacking Fields 



54 

©Kenexa 2002 – 2008 

 

Talent Gateways 

Figure 65: Talent Gateway Details 

 

Figure 66: Edit contact fields and stacking logic 
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User Experience 

Figure 67: Talent Record 

 

Candidate experience on the Talent Gateway: 

Figure 68: Resume/CV profile information page 



56 

©Kenexa 2002 – 2008 
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Recruiter Experience - Deleting Approved and Declined 

Candidate Forms 

This enhancement affects the standard KRB form approval process that your organization can 

enable for individual forms. 

On KRB pages where you can see a list of candidate forms for a candidate (such as the 

Forms tab on the Talent Record and the Multiple forms list page accessed from candidate 

grids), KRB users with appropriate user type privileges for that form can now delete 

candidate forms in the Approved or Declined status. Users cannot delete candidate forms 

that are in the Pending status (awaiting approval). 

How It Worked Before 

The original business rule in force for the standard candidate forms approval process did not 

let users delete approved candidate forms. KRB users with extensive privileges (such as 

Superuser privileges) may have expected to be able to delete approved candidate forms, but 

they could not. (The delete icon  did not display in the list of candidate forms on the 

Forms tab of the Talent Record, nor on the Multiple forms list page for a specific candidate 

accessed from candidate listing grids, so it was impossible to delete the form.) 

Benefits 

KRB users with the appropriate privileges can delete approved and declined candidate forms 

when they are no longer needed. 

Cost 

There is no additional cost for this feature. 

Date Available 

This enhancement is available in R11.5, Build 3 on the February 19, 2009. 

How Do I Get this Feature? 

This feature is available without configuration to KRB users with the appropriate privileges. 

Details, Limitations, and Known Issues 

Here is some additional background information to explain the changes introduced with this 

enhancement. 

Your organization can control access to candidate forms when adding forms or editing form 

attributes in Workbench. In addition, business rules governing form behavior can affect KRB 

users’ access to and actions on candidate forms. 

Depending on your user type, you may be able to search, output, add, view, modify, and 

delete forms associated with your candidates and, in some cases, other users’ candidates. 
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 The actions controlled by user type are: 

⬧  Search [forms] 

⬧  Output [forms] 

⬧  Add / View / Modify My [forms] 

⬧  View all [forms] 

⬧  Modify all [forms] 

⬧  Delete all [forms] 

Some fields on your forms may be encrypted, which means that the information provided in 

those form fields is secure. Users with access to view or update a form with encrypted fields 

can view the decrypted value for the field. 

In addition to controlling access to and actions on candidate forms through user type 

privileges, organizations can enable an approvals process for individual forms. The approvals 

processes include additional business rules which govern the behavior of candidate forms. 

Specifically, when adding candidate forms in Workbench, your organization specifies 

whether the form should be subject to an approvals process. (The default setting is No, 

meaning “no approvals process” for the form.) 

If an approvals process is selected for the form, it can be the standard or rules-based approval 

process. The standard approvals process follows many default business rules enforced by 

KRB. (The rules for the rules-based approvals process are configurable. Once configured, 

they are enforced by KRB.) This update is a result of a change in one of the business rules 

governing the standard approvals process. 

Visible Changes 

For candidate forms that are in the status of Approved or Declined, KRB users can now see 

the active Delete icon in Delete forms column of the candidate forms grid. The candidate 

forms grid is displayed in the following locations: 

⬧  On the Forms tab of the Talent Record [Question: I suspect that I should see something in 

the Form Approval column indicating the form was approved or declined, but I couldn’t 

find an example where there was something in that column. If anyone knows what should 

be in that column, please contact me: Leslie.Smith@kenexa.com] 

Figure 39: Delete icon on the Talent Record Forms tab 
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⬧  On the Multiple forms list page for a candidate. To access this page, navigate to any 

candidate grid (by searching for candidates, or from within req or working folders, for 

example) and click the Forms column to view the Multiple forms list page. 

Figure 40: Delete icon displays for form on the Multiple forms list page 

 

The Delete form column displays the delete icon  in the list of candidate forms under the 

following conditions: 

1.     The KRB user viewing this page has privileges to delete this candidate forms 

(configured when adding or editing the form in Workbench). (Note: If the user does 

not have the necessary privileges, he or she cannot delete forms even if the forms 

meet the next condition.) AND 

2.     The form is in either the Approved or Declined status, and is not in the Pending 

status. 
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Recruiter Experience - Employee Referral Action Date 

Email Trigger 

If an employee referral candidate is hired, the action date reflects the correct hiring date when 

there is an earlier hiring date in addition to the current hiring date. 

How It Worked Before 

In a scenario such as the following, the “Hired” date referenced in an e-mail notification was 

wrong. 

Assume that an employee referred a candidate and that candidate is hired, works at the 

company for two years, and leaves the company. 

At some time later, another employee refers the same candidate. The candidate is hired again. 

A notification e-mail with the original “Hired” status date is sent to the referring employee 

instead of the most recent “Hired” status date. 

Benefits 

The “Hired” action date is reflected accurately for referred employees. 

Cost 

There is no additional cost for this feature. 

How Do I Get this Feature 

This feature is available automatically to KRB users. 

Visible Changes 

With this change, the notification e-mail sent to the referring employee reflects the correct 

Hired status date. 

The system recognizes this employee referral submission as a new submission. It checks the 

submission date for the candidate. Finally, it checks if the employee referral status was set to 

Hire after the most recent submission date before sending the notification e-mail. 
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Recruiter Experience - Enhanced Grid Export to Excel 

KRB users can export candidate and req grids to a Microsoft Excel spreadsheet (2003 and 

2007 versions). This feature works similarly to the ability to print req and candidate grids, 

available in R11.5. 

The capability meets Cybertrust security requirements and works for all supported browsers 

for KRB recruiters: 

⬧  IE 6.0- Candidate Search Results page export 

⬧  IE 7.0- Candidate Search Results page export 

⬧  Firefox - Candidate Search Results page export 

The content exported to the Excel spreadsheet depends on the size of the results set: 

⬧  If the results set is 50 rows or fewer, the entire results set is exported to the Excel 

spreadsheet. 

⬧  If the results set is greater than 50 rows, the entire results set for the current page (rows 1 

through 50) is exported to the Excel spreadsheet. You have to export each page in a 

separate action. 

⬧  The content of the Excel spreadsheet is identical to the content displayed in the Grid except 

that icons are removed and plain text is substituted for links in the spreadsheet. (This 

means that on smaller screens, you might have to scroll to see the entire results set 

contained within the browser window, but the entire results set within that frame is 

exported, nonetheless.) 

How It Worked Before 

Candidate Grids 

As of R10, users could export individual candidates to Excel, but not the entire candidate 

grid. 

Before this update, the Actions menu on candidate listing pages included the option Export 

(Excel). KRB users were required to select one or more candidates in the candidate listing grid 

for export. 

The exported data did not match the data displayed in the candidate grid: Exported results 

defaulted to a different column order than that displayed on the grid. In addition, users were 

required to select one or more candidates to trigger the export, but the exported results did not 

actually reflect the selected candidate(s). 

This example shows the candidate listing grid produced by a candidate search. 

Figure 41: Export (Excel) option the Actions menu on Candidate listing pages 
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Prior to this enhancement, to export portions of the candidate grid, KRB users had to select at 

least one candidate’s checkbox in the Select all column. If no check box was selected, the 

following error message appeared: 

Figure 42: “Please select … candidate” message 

 

After selecting candidate(s), the KRB user could open or save the downloaded file, as shown 

in Figure 43. 

Figure 43: File Download dialog window in previous releases 
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Regardless of the candidate(s) selected in the page displaying the grid, the Excel spreadsheet 

created by the export did not display the selected candidates only, and it did not reflect the 

contents and arrangement of the original candidate grid. 

Figure 44: Export results prior to this enhancement 
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Req Grids 

Prior to this enhancement, you could not export req grid data to Excel – there was no Export 

(Excel) option in the Actions menu on req grid pages. 

Benefits 

KRB users can easily export a results set, as displayed in candidate and req grids, to an Excel 

spreadsheet. 

Cost 

There is no additional cost for this enhancement. 

Date Available 

This enhancement is available in R11.5, Build 1 on the January 8, 2009. 

How Do I Get this Feature? 

This enhancement is available without configuration. 

Visible Changes 

This feature introduces visible changes to candidate and req listing pages in Kenexa Recruiter 

BrassRing. 

Changes to Candidate Listing Pages 

The Export Grid (Excel) option has replaced the Export (Excel) option in the Actions menu on the 

following candidate pages: 

⬧  My Candidates 

⬧  Candidates > 

−        My candidates > Find 

−        My candidates > All 

−        My candidates > 0-Filed 

−        My candidates  > First Interview > My candidates: 0-Filed page 

−        Search 

−        Saved searches 

−        Candidates in queue 
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−        My folders > Working 

−        My folders > My open reqs 

−        View my reqs: Open 

−        My folders > Inbox 

−        My folders > Inactive 

−        Candidate quick search (at the bottom of Candidate listing pages). 

Changes to Req Listing Pages 

The Export Grid (Excel) option has been added to the Actions menu on the following Req listing 

pages: 

⬧  Reqs > View all reqs > 

−        All stages 

−        Pending 

−        Approved 

−        Open 

−        Closed 

−        On hold 

−        Canceled 

−        Deleted 

−        Declined 

⬧  Reqs > View my reqs > 

−        All stages 

−        Pending 

−        Approved 

−        Open 

−        Closed 
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−        On hold 

−        Canceled 

−        Deleted 

−        Declined 

⬧  Reqs > View my drafts > My req drafts page 

⬧  Reqs > Add my req > Set my req defaults > My req defaults page 

⬧  Reqs > Search reqs 

⬧  Req quick search (at the bottom of Req listing pages) 

⬧  Filter folder 

⬧  Req folder contents 

⬧  Working folder contents  

Field Type Validation 

The generated Excel spreadsheet contains the contents of the filtered grid for all field types 

on Candidate listing pages and for Req standard fields (text, numeric, date, email, URL, and 

icon). 

Hypertext links and URLs are changed to text in the Excel spreadsheet. 

Icon columns do not contain any data. 

Form Field Type Validation 

The generated Excel spreadsheet reflects the correct form field type (data type) as listed in 

the candidate listing grid and for custom and standard fields in req listing grids for the 

following field types: Text, Single-select, Radio button, E-mail address, Numeric, SSN, and Date. 

Number of Candidate or Req Rows Exported 

When you click Export grid (Excel), the entire results set contained in the browser window’s 

frame is exported to the Excel spreadsheet (even if you have to scroll to see it). 

Change to Naming Convention for Excel File 

The naming convention for the Excel spreadsheet which is created as a result of the export 

operation has changed from Userfile.xls to a new name which includes the current date 

and time using the following naming convention: YYMMDD-HH-MM-SS.xls. 
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User Experience 

Candidate Grids 

In the Actions menu, on all pages with candidate grids, the Export (Excel) option has been 

changed to Export grid (Excel). 

Figure 45: Export (Excel) option renamed to Export Grid (Excel) in the Actions menu 

 

When you click Export grid (Excel) option, you are no longer required to select a candidate. The 

File Download window appears. 

The naming convention for the Excel file created as a result of this export has changed. You 

can choose to open or save the Excel file. 

Figure 46: New naming convention for Excel spreadsheet containing exported grid 
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If you open the file, the data are displayed in the spreadsheet as shown in Figure 47 below. 

All icons and links are removed from the columns that contain those icons/links. Only 

columns containing text data are displayed in the Excel spreadsheet. Alternatively, you can 

save the file to the desired location in the usual manner. 

Figure 47: Exported candidate grid results in Excel 

 

  

Req Grids 

As a result of this enhancement, you can choose Export grid (Excel) as an option in the Actions 

menu on req grid pages, as shown in Figure 48. 
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Figure 48: Export grid (Excel) option in the Actions menu of View all reqs page 

 

When you click Export grid (Excel) option, the File Download window appears. (Note that the 

naming convention for the Excel file created as a result of this export has changed.) You can 

choose to open or save the Excel file. 

Figure 49: New naming convention for Excel spreadsheet containing exported grid 
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If you choose to save the file, a typical Save As dialog box displays as shown in Figure 50. 

Specify a name and location for the file. The new default name is YYMMDD-HH-MM-SS.xls 

(instantiated with today’s date) unless you change it when saving the file. 

Figure 50: Saving the exported data in an Excel spreadsheet 

 

After you save the Excel file, the Download Complete window displays. Take the desired action 

by clicking Open, Open Folder, or Close. 

Figure 51: Download Complete window 
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 Opening the File: If you open the file (without saving or after saving it), the data are displayed 

in the spreadsheet as shown in Figure 52 below. All icons and links are removed. The Excel 

spreadsheet displays only those columns containing text data. 

Figure 52: Exported req grid results in Excel 
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Recruiter Experience - GQ:  Designate Form Owner and 

Req ID for Forms Only GQ 

Please see “GQ: Enhanced Workflow and Form Security” (the previous feature) starting on 

page 37 for information about this enhancement. 

This feature provides the following capabilities for Create Forms Only GQs: 

⬧  The GQ submitter can assign ‘form owner’ (aka ‘Added by’) to the forms that are created 

by the auto-launch GQs. 

⬧  The GQ submitter can assign a req ID to “Allow req data” GQs that are auto-launched. 

Note: There is a GQ proprieties setting called “Allow req data.” This setting allows fields 

from req forms to be added to GQs.  IF the GQ has this type of data, that is when the Tie 

form(s) to ReqID is needed most. 

Details, Limitations, and Known Issues 

These two features apply to the Create Forms Only GQs, which are auto-launched through a 

Basic Talent Gateway. 

Configuration 

See configuration instructions starting on page 38. 
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Recruiter Experience – GQ: Enhanced Workflow and 

Form Security 

Using the new “Create Forms Only” Gateway Questionnaire, your organization can create a 

complex Gateway Questionnaire to obtain additional data after the candidate has submitted to 

the posted req. By taking advantage of Gateway Questionnaire question branching and the 

ability to combine fields from one or more candidate forms, you can collect data that needs to 

be stored in a variety of places during one workflow. 

The Create Forms Only GQ is implemented as an auto-launch Gateway Questionnaire 

through a Basic Talent Gateway. When the user clicks the URL, the Create Forms Only GQ 

launches automatically. It contains the following content: 

⬧  Minimum candidate profile information, ensuring that the form becomes attached to the 

correct candidate 

⬧  Candidate fields from one or more candidate forms 

Through Basic Talent Gateway settings, the eLink recipient user can additionally identify: 

⬧  A designated Form Creator. The Form Creator is selected from a list of users who have the 

“Add / View / Modify My” privilege for this form. The user selected here will have access to 

the form in KRB. 

⬧  The Req ID to which the forms created by the Gateway Questionnaire should be attached. 

Please see the example workflow on page 40. 

Benefits 

Using the Create Forms Only GQ, your organization can: 

⬧  Collect candidate data on forms for workflows after submission. 

⬧  Use question branching for accurate completion. 

⬧  Attach completed GQ to the correct candidate. 

⬧  Remove necessity of re-entering candidate profile and req information. 

⬧  Let non-logged in user (who does not have access to the system) complete forms. 

⬧  Designate a form owner so only appropriately-privileged KRB user can access the form. 

⬧  Tie forms created by the GQ to a req ID. 

Cost 

There is no additional cost for this feature. 
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Date Available 

This feature is available for configuration in KRB 11.5, Build 5 on April 2, 2009. 

How Do I Get this Feature? 

Please contact your Kenexa consultant for additional information. 

Details, Limitations, and Known Issues 

Caution: CSCs must check with Professional Services on possible impacts before 

implementing this feature. 

Gateway Questionnaires with Create form(s) only setting enabled do not display in the list of 

GQs when KRB users are posting reqs. 

Notes to Kenexa personnel: [Internal Use Only] 

The ‘Designate KRB Form Owner’ and ‘Tie forms to Req ID’ are specifically designed to be 

used with the ‘Create form(s) only’ functionality. 

When an auto-launched Gateway Questionnaire creates the forms, the ‘form creator’ is 

“System Submission.” Any user with the form privilege of “Add/View/Modify My” cannot 

access the forms, because they didn’t create them. The ‘Designate KRB Form Owner’ is used 

so that a designated KRB user can be identified as the ‘form creator’ and therefore have 

access to the form to continue the workflow. 

Additionally, when an auto-launch Gateway Questionnaire creates the forms, it doesn’t know 

which requisition id the candidate forms should be attached.  The ‘Tie forms to Req ID’ 

functionality allows the individual completing the GQ to identify the correct requisition. 

Best Practices 

You must implement the Create Forms Only GQ as an auto-launch GQ from a Basic Talent 

Gateway. 

You can use the Create Forms Only GQ in combination with the Basic Talent Gateway 

setting, Designate KRB form owner. 

If you are auto-launching an “Allow per req form data” GQ, use the Basic Talent Gateway 

setting, Tie form(s) to Req ID. 

Visible Changes 

There are no visible changes without configuration. 

Note: We have listed the following as a visible change in R12, Build 0: 
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When using the Create Forms Only Gateway Questionnaire (which requires an auto-launch 

Basic Talent Gateway) along with the form properties (Form creator + ReqID), the Optional 

ReqID now displays for forms of the following type: 

⬧  Gateway questionnaire job response 

⬧  Single per candidate/req 

⬧  Multiple per candidate/req 

Configuration 

Kenexa personnel or Certified Workbench Users: When creating a Gateway Questionnaire, select the 

check box for the Create form(s) only setting. 

Figure 23: GQ properties, Create form(s) only setting 

 

1.      Kenexa personnel: Configure Basic Talent Gateway details (as shown in Figure 24 on page 

40) as follows: 

a)      Check Auto-launch Gateway Questionnaire. 

b)      Under the Auto-launch Gateway Questionnaire setting, configure the GQ form properties 

listed below. See “Table 3: Gateway Questionnaire form properties” on page 40 for more 

information about these settings. 
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Figure 24: Configure details for Basic Talent Gateway 

 

Table 3: Gateway Questionnaire form properties 

Setting Description  

Designate form creator and/or 

req ID instruction text 

Enter instruction text directed to the KRB user who is 

completing and submitting the Create Forms Only 

GQ. 

 

Show the “Designated KRB 

form creator” list 

Set this setting to Yes so that the list of users who can 

be designated form creators displays on the GQ. 
 

“Designated KRB form 

creator” field label 

Edit the field label Designated KRB form creator if 

desired. 
 

Show the “Tie form(s) to req 

ID” field 

Set this setting to Yes so that the GQ displays the list 

of  Req IDs for selection. 
 

“Tie form(s) to req ID” field 

label 

Edit the field label for Tie form(s) to req ID if desired.  

User Experience 

In this example, an organization is collecting offer information from a Hiring Manager who is 

working externally. 
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1.      The recruiter eLinks a blank Candidate Information Form to a Hiring Manager. This form has 

autofill fields for basic candidate information that the hiring manager will need to complete 

the “offer” Gateway Questionnaire. This step is necessary because GQs aren’t able to autofill 

information from the Talent Record, and the eLink recipient needs basic information to 

identify the candidate to whom these forms should be attached. 

Figure 25: eLink blank form from the Talent Record Forms tab 

 

2.      The Hiring Manager receives the e-mail and launches the Candidate Information Form. 

Figure 26: Example eLink e-mail  
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3.      The Hiring Manager clicks on a link provided below the minimum profile information in 

a client-configurable label field to launch the offer Gateway Questionnaire. 

Figure 27: Link for auto-launching the Gateway Questionnaire 

GQ includes minimum 

profile information for the 

candidate and the req ID 

(Job Number in this 

example). 
  

 

4.      The Gateway Questionnaire form properties window displays. 

a)      Select the Designated KRB form creator. 

b)      Select the req ID to which this submission should be tied. 

c)      Click Next. 

Figure 28: GQ form properties window 
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5.      The Create Forms Only Gateway Questionnaire is launched: 

Figure 29: GQ is launched 
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Recruiter Experience - GQ is Re-attached to Reposted 

Reqs Automatically 

Reqs removed from On Hold (or Un-canceled) retain their connection to Talent Gateway GQs 

associated with their previous posting. 

When you post a req to a Talent Gateway and select an associated GQ, the GQ is attached to 

the req and presented to the candidate as part of the application workflow. 

With this enhancement, if you un-cancel a req or remove a req from “on hold,” the previously 

attached Gateway Questionnaire is re-attached to the req when the req is re-posted. You can 

remove that GQ and select a different one if desired. 

How It Worked Before 

Prior to this enhancement, when reqs were put On Hold or canceled, they were automatically 

un-posted from the Talent Gateway and the connection to a Gateway Questionnaire was 

severed. If, that same req was removed from on hold or un-cancelled at a later time (so that it 

is once again actively open), KRB users had to explicitly select the Gateway Questionnaire 

when re-posting the req. 

Benefits 

KRB users do not have to remember to re-attach the GQ when reposting a pormerly “on 

hold” or canceled” req. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 1 on January 8, 2009. 

How Do I Get this Feature? 

This feature is available automatically without configuration. 

Visible Changes 

You will notice a visible change when removing a req from “on hold” or when “un-

cancelling” a cancelled req: The req retains its association with the GQ from the previous 

posting by default; you do not have to remember to re-attach the GQ! When reposting the 

req, you can change the selection to None or to a different GQ if desired. 
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Recruiter Experience - Hourly and High-Volume 

Enhancements 

The new portal pages can be configured to support the Hiring Manager’s workflow for hourly 

and high-volume hiring. Additionally, triggers are available to automate HR Status updates 

based on Assessment results and the Talent Gateway score. 

Benefits 

The hourly / high-volume portal: 

⬧  Streamlines the Hiring Manager’s workflow 

⬧  Automatically updates HR status based on Talent Gateway and/or Assessment scores 

⬧  Automatically files to candidates based on proximity search 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 12 on April 23, 2009. 

How Do I Get this Feature? 

Please contact your Kenexa consultant for assistance with this feature. A user from your 

organization will have to complete Certified Workbench Level IV training for portal panel 

configuration. 

Details, Limitations, and Known Issues 

Caution: CSCs must check with Professional Services on possible modifications required to 

triggers before turning on the client setting. 

Visible Changes 

There are no visible changes in KRB without configuration. 

Hourly and High-Volume Preview 

Figure 15: Hourly Portal Page – partially built 
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Figure 16: Hourly Portal Page 
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Recruiter Experience - Increased Security for “Undo 

status” Workflow 

This enhancement stops KRB users from performing the Undo status action on candidates who 

will revert to an HR status that is hidden due to a user type setting for those users. 

Your organization can elect to hide certain HR statuses for candidates in req folders by user 

type. Your Kenexa consultant or Certified Workbench User configures the HR statuses to be 

hidden by user type in Workbench. Due to this setting, some KRB users would have access to 

some HR statuses for candidates in req folders, but not others. 

As a result of this enhancement, when users click the Undo status button for a candidate who 

will revert to a status hidden for those users, the system checks the user’s user type “Admin 

HR status preferences in req folders” setting. If the HR status resulting from taking the Undo 

status action is hidden for this user type, the system blocks the user from performing the Undo 

status action and displays the following error message: “An undo HR status action will not 

allow you to view this candidate.”  Users can close the message window at that point. 

How It Worked Before 

Previously, KRB users could undo the HR status, thereby restoring the candidate back to an 

HR status that they did not have privileges to view. 

Benefits 

Organizations do not have the ability to monitor HR status changes for all candidates. Your 

organization can exert tighter controls on which user roles can take certain HR status actions 

and prevent users from making costly mistakes. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 5 on April 2, 2009. 

Visible Changes 

When the KRB user tries to undo an HR status for a candidate for whom that user does not 

have the privileges, the system does not permit the user to perform the Undo status action and 

the following error message displays: 

Figure 33: Undo HR status message 
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Configuration 

This is existing Workbench functionality performed by Kenexa personnel or the Certified 

Workbench User.  

This feature works when the user type has at least one of the Candidate Actions privileges 

shown in Figure 32, but also has the Hide candidates in req folders for this user type in the following 

statuses enabled for one or more HR statuses. 

The configuration steps for this feature are: 

1.      In Workbench, select Tools > Users > User types. 

2.      Select the user type who will have the restricted set of privileges for some HR statuses. 

3.      Check at least one of the Candidate Actions privileges in the list below for that user type. 

Figure 34: Candidate Actions privileges – HR status 

 

4.      On the User types page, select Admin HR status preferences in req folder. 

5.      Select the HR statuses to hide for this user type. 

6.      Save the changes. 

Figure 35: “Hide candidates in req folders…in the following statuses” setting 
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User Experience 

KRB users with this combination of user type settings encounter the Undo status button in 

several workflows: On the HR status update page, file to folder, file to req pages, Move to 

folder/req, and Copy to folder/req (anywhere the Update status and Update same status options 

display). 

When the user clicks the Undo status button, KRB displays the error message “Performing an 

Undo HR status action will not allow you to view this candidate.” 

Figure 36: Update same status window accessed from Req folder 

 

Figure 37: Undo status button in Update same status window 
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Figure 38: Error message displayed 
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Recruiter Experience - Mobile Device Approvals: 

Removed Unnecessary OK Button 

Kenexa removed an unnecessary OK button in the Mobile Devices approvals process. When 

the Mobile Device user is approving a req or a candidate form, the Approved req process page 

launches directly. A message displays at the same time, indicating that the req has been sent 

to the next approver. 

How It Worked Before 

Mobile Device users had to click the unnecessary OK button to move to the next step in the 

process instead of going directly to the next step. 

Benefits 

This feature eliminates an unnecessary step for Mobile Device users. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 2 on January 29, 2009. 

How Do I Get this Feature 

This feature is available automatically on mobile devices. 

Visible Changes 

The OK button is removed in the workflow and the Mobile Device user sees the Approved req 

process page immediately. 
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Recruiter Experience - New Portal Pages Panel 

Configuration 

Please go to the KRB 12 Enablement page on the R12 Launch site and to the URC for 

documentation and information about training. 

Configuration 

After the client setting is enabled, users who have completed Certified Workbench Training 

for Level IV can configure portal panels. In addition, KRB users can configure some 

elements in their user interface. 

Kenexa Personnel: Set the Workbench client setting New UI to Yes. [Note: This setting is currently 

in the Restricted Settings section at the bottom of the Edit client settings page in Workbench.] 

Please see the Workbench Self-Service Online Help document for full instructions for 

configuring panels. 
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Recruiter Experience - New Recruiter and Hiring 

Manager Portal Pages 

This is the first phase of the project to update the KRB user interface. This phase focuses on 

the welcome page. It includes enhanced panels, configuration by role, and a simplified 

workflow for viewing and updating HR status. 

The following panels are available for R12: 

⬧  My Open Reqs 

⬧  Candidate Results (Applies to My Open Reqs and My Candidates) 

⬧  My Reqs Pending Approval 

⬧  My Candidates 

⬧  Quick Links 

⬧  My Calendar (Requires Outlook 2003 or higher with plug-in for IE 6 only) 

⬧  Welcome Message 

How It Worked Before 

In the current user interface, a user must know where they are going before they can get 

there. This slows down experienced users and makes it difficult for new users to navigate 

without training. 

Benefits 

The new portal pages increase user efficiency and productivity through usability 

enhancements. In addition, your organization can define portal page contents and layouts by 

user type. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available to be turned on in KRB 12 on April 23, 2009. 

How Do I Get this Feature? 

Please contact your Kenexa consultant about preparation for portal enablement. 

Kenexa is introducing a new Workbench Tier IV certification and training for portal panel 

configuration. A designated user must complete this training. 
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Table 1: Workbench Tier IV Certification Training Schedule 

Internal enablement April 3, 2009  

Web sessions for client certification May 6, 2009  

Portal Page Documentation Availability 

See page 7 for information about documentation available in the R12 bundle for Kenexa 

personnel. The following documentation for the new Portal Pages will be posted for clients 

on the URC on April 23rd: 

Portal Page end-user online help (slightly updated version checked in for  April 20th). 

Section added to Workbench Self-Service Online Help (accessed from Help link in 

Workbench Self-Service, on the internal R12 Launch Site, and on the R12 Documentation 

page of the URC. 

Note: The Enablement training recording was already posted for Kenexa personnel. 

Details, Limitations, and Known Issues 

The portal pages are turned on at the user type level. Once they are turned on for a user type, 

users of that type have access to the new panels but no longer have access to the legacy 

“Welcome Page” panels, in particular the TRM dashboard panels, until they are rebuilt. 

Added June 30, 2009: The New Portal Page and associated Help files are available in US 

English only for this release. All other supported KRB Recruiter languages will be added in a 

future release. 

Visible Changes 

There are no visible changes without configuration for this feature. 

Configuration 

Please see the section “New Portal Pages Panel Configuration” on page 25 for more 

information. 

Please contact your Kenexa consultant for assistance in preparing for panel configuration for 

the new portal pages. 

Customizing Panels within KRB 

Once portal pages are enabled and configured for one or more of your organization’s user 

types, those KRB users can: 

⬧  Minimize and maximize panels 
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⬧  Drag and drop panels 

⬧  Change panel height 

⬧  Adjust page column width 

  

Portal Pages Preview 

Once this feature is turned on for a user type, the user will see the New Portal page upon 

login, along with new headers and footers throughout the application. The menu navigation 

appearing in the header is unchanged; selecting items from the menu directs users to the 

current KRB pages. 

The following screens show examples of how the Portal Page can be configured for different 

user types based on their role in the hiring process: 

Figure 9: New Portal Page - Recruiter 

 

Figure 10: New Portal Page – Hiring Manager 
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Figure 11: Candidate Results Panel 

 

Figure 12: Update Status for Multiple Candidates 
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Figure 13: Update Status for Multiple Candidate (continued) 
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Recruiter Experience - Restricting Access to Offer Letter 

Attachments to Req Team 

Your organization can elect to restrict access to offer letter attachments to members of the 

Req team under certain conditions. When this feature is enabled, only members of the Req 

team can see, attach, and send the offer letter as an attachment to the e-mail to the candidate 

and subsequently view the offer letter on the candidate’s Talent Record. 

The new Workbench client setting (Enable Offer Letter Viewing Restriction) controls this behavior. 

When this setting is set to No (the default setting), all users with the Communications user 

type privileges can view, update, and even delete the offer letter; attach the offer letter to an 

e-mail, and send the communication to the candidate even if they are not members of the Req 

team. When the client setting is set to Yes, only KRB users who are members of the Req team 

can perform those actions for a specific req. 

 Once enabled, only members of the req team can: 

1.       From within the req folder or from the Talent Record, create an e-mail to the candidate 

to whom the offer is directed by clicking Send communication in the Actions menu. 

2.      Attach the offer letter (already created using the “Create document” feature) to the e-

mail. 

3.      Send the e-mail to the candidate. 

Once the e-mail is sent, the record of the e-mail is stored on the Communications tab and the 

offer letter attachment is stored on the Attachments tab of the candidate’s Talent Record. 

How It Worked Before 

Prior to this enhancement, all logged-in users with Communications privileges could take the 

following actions even if they were not members of the Req team: 

⬧  View, update, and delete an offer letter attached to a candidate’s Talent Record 

⬧  Attach an offer letter to an e-mail and send it to a candidate 

Benefits 

Exert more control over who can upload and send, view, edit, and delete offer letters. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 2 on January 29, 2009. 
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How Do I Get this Feature? 

Please contact your Kenexa consultant for assistance with this feature. 

Details, Limitations, and Known Issues 

Your organization must determine how to name offer letter documents and offer letter e-

mails that are sent to candidates. The name is visible to anyone who can view the Talent 

Record. 

Visible Changes 

Workbench: There is a new client setting, Enable Offer Letter Viewing Restriction. 

There are no visible changes without configuration in KRB. 

Configuration 

The major configuration steps for this feature are: 

1.      Kenexa consultant: Set the new client setting, Enable Offer Letter Viewing Restriction, to Yes. 

2.      Kenexa consultant or Certified Workbench User: (This step may not be necessary. It is 

provided FYI.) Users must have the following user type Communications privileges turned 

on: 

−        Communications – enable 

−        Create document – enable 

−        Document templates – add 

−        Document templates – administer 

−        Document templates – delete 

−        E-mail templates – add 

−        E-mail templates – administer 

Note: KRB users must be selected as members of the Req team when the req is created (as 

described in step 4 below. 

3.      KRB templates manager: 

a)      Determine which of your existing document templates should be capable of 

being  restricted to Req team members. 

b)      For each document template you identified in the previous step: 
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                         i.       Edit the document template through the Edit action on the Document templates grid [KRB > 

Admin > Communications > Manage document templates] 

                       ii.       Select the checkbox for Restricted offer letter above content area and save the template. 

c)      When creating document templates in the future, check the Restricted offer letter setting 

when it is appropriate to restrict viewing of documents based on this template to Req team 

members only. 

4.      KRB user who creates the req: Select the members of the Req team when creating the 

req. 

5.      Updated 24 April, 2009: KRB user who creates the e-mail: Select a document to upload that 

is based on a document template that has the Restricted offer letter checkbox checked. 

Workbench 

In Workbench, set the new client setting Enable Offer Letter Viewing Restriction to Yes, as shown 

in Figure 17. The default setting is No. 

Figure 17: Enable Offer Letter Viewing Restriction client setting 

 

The default system behavior is as follows: When Enable Offer Letter Viewing Restriction is set to 

No (the default setting), KRB users with the Communications user type privileges (see the 



97 

©Kenexa 2002 – 2008 

next section for a list) turned on can take the following actions, whether or not they are 

members of the Req team: 

⬧  Reqs > View my reqs > Open > Talent Record > Attachments tab > View | Update | Delete offer letter 

⬧  Reqs > View my reqs > Open > Talent Record > Send Communication > E-mail template > Upload 

attachment (all offer letters are available for selection in the list) 

⬧  Candidate search > Talent Record > Send Communication > E-mail template > Upload attachment (all offer 

letters are available for selection in the list) 

⬧  Candidate search > Talent Record > Attachments tab > View | Update | Delete offer letter 

When Enable Offer Letter Viewing Restriction is set to Yes, only those KRB users with the same 

Communications user type privileges (see the next section for a list) turned on who are also 

members of the Req team can take the following actions: 

⬧  Reqs > View my reqs > Open > Talent Record > Attachments tab > View | Update | Delete offer letter 

⬧  Reqs > View my reqs > Open > Talent Record > Send Communication > E-mail template > Upload 

attachment (offer letter for the specific req) 

⬧  Candidate search > Talent Record > Send Communication > E-mail template > Upload attachment (offer 

letter for the specific req) 

⬧  Candidate search > Talent Record > Attachments tab > View | Update | Delete offer letter 

Configuring Document Templates in KRB 

Your organization’s template manager configures document templates (which are used for 

offer letters) in KRB. When the Enable Offer Letter Viewing Restriction setting is turned on in 

Workbench, the checkbox field Restricted Offer Letter displays above the text editor on the Add 

document template (as shown in Figure 18) and the Edit document template pages. It is unchecked 

by default for new and existing document templates. 

Selecting the Restrict Offer Letter checkbox for the document template means that offer letters 

created using this document template will be restricted only to members of the Req team. 

If you leave the Restricted Offer Letter setting unchecked on a document template, all logged in 

KRB users with Communications privileges turned on can attach documents created using 

this document template to e-mails. They can also view, edit, and delete the document (such as 

an offer letter) on the Attachments tab of the Talent Record. 

Figure 18: Add document template – Restricted Offer Letter setting unchecked by default 
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When the Restricted Offer Letter setting is checked, logged in KRB users with Communications 

privileges turned on who are also members of the Req team are the only users who can attach 

documents created using this document template to e-mails. These same users can also view 

the document (such as an offer letter) on the Attachments tab of the Talent Record. 

Figure 19: Add document template – Restricted Offer Letter is checked 

 

  

User Experience 

Candidate Search Results 

Once this feature is enabled, when KRB users who are not Req team members conduct a 

candidate search, the Candidate search results page displays the attachment as an inactive link 

to non-Req team members. 
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Viewing, Editing, and Deleting Offer Letter Attachments 

Once this feature is enabled, and your organization’s template manager has configured 

document templates to be restricted to Req team members only, KRB users who are not 

members of the Req team for a specific req can access the Attachments tab of the Talent 

Record and see that there is an offer letter attachment listed in plain text in the File column of 

the attachments grid. However, these users cannot view, edit, or delete the offer letter because 

they are not Req team members. 

Req team members, on the other hand, can click the offer letter attachment hyperlink to view, 

edit, or delete the offer letter attachment. 

Figure 20: Req team members see live hyperlink to offer letter attachment on the Talent 

Record 

 

Sending a Communication to the Candidate 

When the feature is turned on and the “Restricted offer letter” box is checked on the 

document template: 

⬧  KRB users who are members of the Req team can upload an offer letter as an attachment 

when sending an e-mail to a candidate. 

Figure 21: Req team members can see and upload the offer letter as an attachment 
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⬧  KRB users who are not members of the Req team can send an e-mail communication to the 

candidate but cannot upload an offer letter as an attachment to that e-mail. 

Figure 22: Non-Req team members do not see the offer letter in the list of attachments 

 

Once the KRB user who is a Req team member sends the e-mail with the offer letter 

attachment, it is listed on the Communications tab of the Talent Record. The offer letter 

attachment is listed on the Attachments tab of the Talent Record. 
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Recruiter Experience - “Save Without Routing” Button 

Removed for Non-System Users 

Non-system users can create a req form from an eLinked a blank req but they no longer see 

the Save without routing for approval button. 

KRB system users will still have all the options available to them, including the ability to 

save without routing for approval, if they are part of the Req team. 

How It Worked Before 

Prior to this enhancement, non-system users who were eLinked a blank req could create the 

req form and click the button Save without routing for approval. 

Benefits 

This enhancement stops non-system users from circumventing the approval process for a req. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 1 on January 8, 2009. 

How Do I Get this Feature? 

This feature is available automatically without configuration. 

Visible Changes 

Non-system users no longer see the Save without routing for approval button in an eLinked blank 

req. 
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Recruiter Experience - Time Zones Renamed 

Four time zones applicable to both Canada and the United States have been renamed as 

shown in Table 4 below. 

Table 4: Renamed Time Zones 

New Time Zone Name Former Time Zone Name  

Pacific Time (US & Canada) US Pacific  

Mountain Time (US & Canada) US Mountain  

Eastern Time (US & Canada) US Eastern  

Central Time (US & Canada) US Central  

Atlantic Time (Canada) Atlantic  

How It Worked Before 

Time zones applicable to Canada referred to the US only. See Table 4 above. 

Benefits 

This way of referencing the time zones is more globally appropriate. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 3 on February 19, 2009. 

How Do I Get this Feature? 

Kenexa personnel must configure the client settings Job Posting Removal Time & Time Zone and 

Job Posting Removal Time Zone (Default) to enable this functionality in KRB. If your organization 

has already enabled this feature, users will see the renamed time zones automatically. 

This feature is available without configuration, assuming your organization has already 

enabled the two job posting removal time zone settings. 

Visible Changes 

You can see this change to time zone names in the following locations: 

⬧  Workbench (internal): Job Posting Removal Time Zone (Default) [Internal Use Only]. Please see the 

Configuration section on page 77. 
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⬧  KRB: Send interview request and Schedule interview windows, and the associated Selection details 

window for time zones. Please Figure 54, Figure 55, and Figure 56 starting on page 75. 

⬧  KRB – Edit posting options window in the Zone field in Figure 57 on page 77 below. 

“Interview schedule” Tab on the Talent Record 

Navigate to a candidate’s Talent Record (for example, by using Candidate search or through 

a req folder) and select the Interview schedule tab. On this tab, click Send interview request or 

Schedule interview to open the appropriate windows. Both windows include the Time Zone field. 

Figure 54: “Send interview request” window with Time zone field 

 

Figure 55: “Schedule interview” window with Time zone field 
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 “Selection details” Window for Time Zones 

Figure 56: Selection details window with updated time zone labels 

 

“Edit posting options” Page 

Figure 57: “Edit posting options” page – Zone drop-down list 

 

Configuration 
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Workbench (Internal) 

Note: The setting Job Posting Removal Time & Time Zone must be set to On to make this setting 

active. 

Figure 58: Job Posting Removal Time Zone (Default) setting – list of time zones 
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Security - Cookie Expiration Settings for KRB and TGs 

Renamed 

To maintain consistency with the new Agency Manager “session expiration” settings, the 

settings CookieExpiration and CookieExpiration Warning Prompt have been renamed to the 

following: 

⬧  Session Expiration: KRB and Talent Gateways 

⬧  Session Expiration warning prompt: KRB and Talent Gateways 

  

  



108 

©Kenexa 2002 – 2008 

Security - Generic Login Messaging 

The Generic Login Messaging feature includes the Generic Login Message and the Generic 

“Forgot Password” Confirmation Message. These two messages convey just enough 

information to users when they are unable to log in, and/or when they click the “forgot my 

password” link, to get them to the next step. 

The “Generic Login Messaging” feature is available for KRB, Talent Gateways, and Agency 

Managers. It is controlled by three new Workbench client settings. By default, when you log 

in to Workbench and see these settings for the first time: 

The Generic Login Messaging selection for Agency Manager is Off. 

The Generic Login Messaging selection for Talent Gateways is Off. 

The Generic Login Messaging selection for KRB is Off. 

The “Generic Login Messaging” feature is also available in Workbench as the new standard 

messaging format. 

Once the client setting is enabled, the system displays the Generic Login Message on the 

login page and the Generic Confirmation Message on the “forgot password” page for the 

appropriate product. 

Benefits 

Kenexa is implementing state-of-the-art security features, some of which are client-

configurable. Your organization can use Generic Login Messaging for the suite of Kenexa 

Recruiter BrassRing products alone or in combination. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available to be turned on in R12, Build 0 on April 23, 2009. 

How Do I Get this Feature? 

Please contact your Kenexa consultant for help with enablement. 

Details, Limitations, and Known Issues 

You can enable Generic Login Messaging for Agency Manager, Talent Gateways, and/or 

Kenexa Recruiter BrassRing at any time. You can disable Generic Login Messaging at any 

time. 
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Note: Talent Gateways include an additional workflow which prompts users with a set of 

security questions if no valid e-mail address exists on file.  This feature has not impact on the 

additional Talent Gateway workflow. 

Visible Changes 

There are no visible changes associated with this feature without configuration. 

Configuration 

Kenexa personnel: In Workbench, navigate to the Edit client settings page for the client. Set 

the generic login messaging settings to On for each of KRB, Agency Manager, and/or Talent 

Gateways, as desired and save your changes. 

Figure 70: Workbench Client Settings for Generic Login Messaging 

 

There is no client setting for the Generic Confirmation Message in Workbench. It is enabled 

for Workbench by default. 

KRB/TG/AM User Experience 

Generic Login Error Message 

On the login page, the following generic login error message displays under the conditions 

listed below: “The information you entered does not match our records. Please try again.” 

−        If the KRB, Talent Gateway, or Agency Manager user enters an invalid username, 

password, client identifier (if applicable); or 

−        If the selected account has been locked out 

Generic “Forgot Password” Confirmation Message 

When the Generic Login Message is turned on for KRB, the “forgot password” workflow is 

as follows: 

On the login page, for KRB, Talent Gateways, or Agency Manager, the user specifies either a 

valid or invalid username/e-mail address and company identifier (if applicable), and then 

clicks Continue or Recover my password. 

The “forgot password” page loads and the Generic Confirmation Message displays: 

You have asked to recover your password. For your protection, this operation is carried out 

through a secured e-mail, which has been sent to the address associated with your user 
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profile. Please click on the link in the e-mail to reset your password. Check your e-mail for a 

message called “Password recovery.” 
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Security - Session Time-out for Agency Managers 

The Session Timeout feature is new for all Agency Managers. 

By default, a login session for the Agency Manager user expires 24 hours from the time that 

the user last took an action, as detected by the system. 

By default, Agency Manager users see a warning prompt telling them that their session will 

expire 5 minutes before the session expiration takes place. The user can click OK to extend 

the session at some point within the 4 minutes and 59 seconds duration before the session 

expires. 

If the user does not click OK to extend the session within the appropriate amount of time, the 

session ends and the user is automatically logged out of the system. 

Your organization can elect to configure the Session Timeout settings to be different lengths 

of time than their default values. 

Benefits 

Kenexa is implementing state-of-the-art security features, some of which are client-

configurable. Your organization can use the “Session Timeout” feature for its Agency 

Managers. (Note: Talent Gateways already have the “Session Timeout” capability.) 

Cost 

There is no additional cost for this feature. 

Date Available 

The default settings are enabled automatically for this feature in R12, Build 0 on April 23, 

2009. The feature is available for configuration at that point. 

How Do I Get this Feature? 

Please contact your Kenexa consultant for help with configuration if you want to change the 

Session Timeout settings. 

Details, Limitations, and Known Issues 

The Session Timeout feature for Agency Managers is controlled by two new Workbench 

client settings: Session Expiration: Agency Manager and Session Expiration Warning Prompt: Agency 

Manager. 

The settings for both values are applied to all Agency Managers for your organization. 

The Session Expiration: Agency Manager setting sets the amount of time before the user is logged 

out due to inactivity. 
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The Session Expiration Warning Prompt: Agency Manager setting sets the amount of time between 

when the session timeout warning prompt is displayed to the user due to inactivity, and the 

actual time when the session expires and the user is logged out automatically. 

Visible Changes 

There are visible changes associated with this feature without configuration but users are not 

likely to experience them. The Session Timeout warning prompt and the Session Timeout are 

new visible behavior for Agency Manager users. After 24 hours of inactivity (the default 

setting), the user sees the Session Expiration warning prompt. 5 minutes later, the user is 

logged out of Agency Manager if he or she takes no action. (So if the client does not change 

the default values associated with the two client settings, this would affect users who had 

failed to log out of their system at the beginning of the weekend or in any case where 24 

hours go by without any user activity.) 

Configuration 

Who does this: Kenexa personnel 

To enable Session Timeout settings for Agency Managers: 

1.      In Workbench, select Admin > Manage clients > Search for client > Edit client settings. 

Figure 74: Agency Manager Session Expiration client settings in Workbench 

 

2.      Select the length of time that can elapse before the session expires: 
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15 min 

30 min 

1 hr 

2 hrs 

3 hrs 

4 hrs 

8 hrs 

24 hrs (the default) 

3.      Select the length of time that can elapse between the displaying the warning prompt to 

the user and expiring the session. 

30 sec 

1 min 

2 min 

5 min (the default) 

10 min 

4.      Click Save. 

Agency Manger User Experience 

The length of a session and the length of time between the warning prompt and the session 

expiration are determined either by the default settings, or by your organization’s choices for 

the two Workbench settings that control the “session timeout” behavior. 

By default, the Session Timeout warning prompt (as shown in Figure 75) displays 5 minutes before 

the system logs the user out automatically if the user takes no action in response to the 

warning prompt. 

Figure 75: Session Timeout warning prompt 
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By default, the user has a little less than 5 minutes to click OK to extend the session. If the 

user does not respond to the warning prompt, the session ends exactly 5 minutes after the 

warning prompt is displayed. The Session expiration message displays, as shown in Figure 

76: 

Figure 76: Session expiration message 

 

The user is redirected to the login page. 
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Security - Strong Password for Talent Gateways 

Your organization can elect to enable the “Strong Password” feature for Talent Gateways. 

When this feature is enabled, candidates are required to create passwords which meet the 

stringent criteria outlined below. 

Benefits 

Kenexa is implementing state of the art security features, some of which are client-

configurable. Your organization can use the “Strong Password” feature for its Talent 

Gateways. 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available to be turned on in R12, Build 0 on April 23, 2009. 

How Do I Get this Feature? 

Please contact your Kenexa consultant for help with enablement. 

Details, Limitations, and Known Issues 

The Strong Password feature for Talent Gateways is controlled by a new Workbench client 

setting, Talent Gateway password strength. (Please see the Configuration section for more 

information.) You can enable and disable Strong Password for Talent Gateways at any time. 

The guidelines for creating and resetting passwords are displayed to the Talent Gateway user 

on the Create login, Reset password , and Career Site Help pages of the Talent Gateway. The 

guidelines for creating strong passwords are: 

⬧  Your password must be a minimum of 8 characters and a maximum of 25 characters. 

⬧  Your password must contain at least one of the following special characters: 

{}[],.<>;:'"?/|\`~!@#$%^&*()_-+=. 

⬧  Your password may not contain spaces 

⬧  Your password may not be the same as your login e-mail address 

⬧  Your password may not be the same as any of the 5 preceding passwords 

⬧  Your password will be case-sensitive 

Visible Changes 
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There are no visible changes associated with this feature without configuration. 

Configuration 

Kenexa personnel: In Workbench, navigate to the Edit client settings page for the client. Set the 

Talent Gateway password strength setting to Strong. 

Figure 1: Workbench Client Control 

 

Talent Gateways User Experience 

Talent Gateway users see password guidelines (either the default set or Strong Password set 

of guidelines) when creating a new login, resetting their password by editing their profile, or 

resetting their password after clicking the Forgot my password link. 

Default Password Requirements 

If clients leave the Talent Gateway password strength setting set to Default, or return to that setting 

at some point in the future after using the Strong Password option, the default set of 

requirements for passwords are in force: 

⬧  The password must be a minimum of 6 and a maximum of 25 characters. 

⬧  Your password may not be the same as your username. 

⬧  Your password may not be the same as any of the 2 preceding passwords. 

⬧  Your password will be case-sensitive. 

Strong Password Requirements and Messaging 

If clients set the Talent Gateway password strength setting to Strong, Talent Gateway users 

encounter the Strong Password requirements when resetting a forgotten password, viewing 

tips for passwords, and when changing their passwords by editing their profiles. 

Talent Gateways can support a unique string username or e-mail address as username. (The 

type of username is controlled by a client setting.) The password guidelines for the Strong 

Password feature are displayed slightly differently depending on whether users are logging in 

with a unique string username or with an e-mail address as username, as shown in Figure 71 

and Figure 72: 

Figure 71: Password Guidelines for username only login 
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Figure 72: Password Guidelines for e-mail address as username login 

 

Creating a New Login 

When candidates try to create a new login or existing Talent Gateway users must reset their password 

for a Talent Gateway, and the “Strong Password” feature is turned on, they see the extended set of 

password guidelines on the Create login and Reset password pages respectively, as shown in Figure 

73 and Resetting a Password 

Talent Gateway users enter the “reset password” process when they click the Forgot my 

password link on the login screen, or when they elect to change their password as part of 

editing their individual profile on a Talent Gateway. 

When users click the Forgot my password link, the system sends a “password recovery” e-mail 

to the user which contains the password reset link (Click here to reset your password). 

When users change their password as part of editing their profile, they must log into the 

Talent Gateway, click Edit your profile and then Change password. 

 below. 

Figure 73: Create Login page with “Strong Password” guideline 
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Resetting a Password 

Talent Gateway users enter the “reset password” process when they click the Forgot my 

password link on the login screen, or when they elect to change their password as part of 

editing their individual profile on a Talent Gateway. 

When users click the Forgot my password link, the system sends a “password recovery” e-mail 

to the user which contains the password reset link (Click here to reset your password). 

When users change their password as part of editing their profile, they must log into the 

Talent Gateway, click Edit your profile and then Change password. 

Career Site Help 

The password guidelines are included in the Career site help system as well. 
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Smart Approval 

Smart Approval has two enhancements: Improved workflow selection and improved sorting 

usability. 

⬧  The new “All Workflows” option has gives users the ability to view all workflows relevant 

for a particular status and user. 

⬧  The sorting selection is retained with pagination. 

−        Visual cues have been added to indicate if a column allows sorting. 

−        Visual cues have been added to indicate which column is being sorted and in which 

direction. 

Figure 95: Active Workflows for Smart Approval 
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Talent Gateways - Pre population of Data on SSO TGs, 

and on GQs 

Your organization can pre-populate candidate profile fields and Gateway Questionnaire 

questions on SSO-enabled Talent Gateways using xml. 

The xml can specify the display property for each field [whether the field is editable, read-

only, or hidden (Note: Only form fields can be “hidden”)]. 

The following documentation is posted on the R12 Enablement Documents page in the 

“TG_GQ Pre-population via xml” folder. (Go to the R12 Product Launch Portal > KRB 12 > 

R12 Enablement Documents > TG_GQ Pre-population via xml.) 

TG Import xml rules 

TG_GQ Prepopulation User Guide 

Benefits 

This capability: 

⬧  Eases the candidate’s application process, thereby increasing your internal candidacy pool 

⬧  Ensures the accuracy of the data included in the submission 

⬧  Provides data consistency across client applications 

Cost 

There is no additional cost for this feature. 

Date Available 

This feature is available in KRB 11.5, Build 4 on March 12, 2009. 

How Do I Get This Feature? 

Client resources create the xml files. Kenexa resources supply the client with a user guide, 

sample xml files, and rules. 

Details, Limitations, and Known Issues 

The Talent Gateway must be SSO-enabled. 

Education and Work Experience each have one display setting for all fields associated with 

them; either all fields are editable, or all fields are read-only. 

Visible Changes 
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There are no visible changes without configuration. 
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Workbench - Configuration Publish 

Kenexa personnel can publish configured data from the Source to the Target environment. 

The feature includes “Single entry  publish,” which lets trained users publish pieces of 

Workbench data from Staging to Production. 

Users can generate two reports: the Difference Report or Publish Report. 

Users can select individual or all functional areas. The functional areas available in R12 are: 

User types Users 

Code types Agency Manager 

Gateway Questionnaire Talent Gateway 

HR Status Codes 

Org Groups Acknowledgements 

Instructions Resume Security Access  Groups 

Approvals Search Fields 

Candidate Types   

Functional Areas to be Added in the Future 

⬧  Forms 

⬧  Questions 

⬧  Options 

How It Worked Before 

To move client-configured data changes from one environment to another, clients had to 

submit a maintenance request to Systems Engineering to accomplish any post-installation 

publishes. 

Benefits 

Your organization can contact your Kenexa consultant to make changes to your published 

environment instead of submitting a maintenance request. Your requested changes can be 

made faster and more easily. 

Cost 

There is no additional cost for this feature. 

Date Available 

The first phase of Configuration Publish is available in R12 on April 23, 2009. Important: 

Product Management will make an internal training announcement after R12 is released. 
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Details, Limitations, and Known Issues 

The following functional areas will be added after R12: 

Forms 

Questions 

Options 

Configuration 

The client setting is listed in the Restricted Settings area. You must contact Engineering for 

help to enable or disable this setting. 

The setting is restricted to Superusers and Tech Services users 

Figure 69: Workbench client settings – Restricted Settings area 

 

  

 


